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1.  はじめに                                           
この資料は、X-Plane 11 用シーナリーを作成する要領をまとめたものです。LR 社の資料を元に筆者の理解す
る範囲で感想も交えて書いたのでご注意下さい。誤りがあればご連絡下さい。
なお、作成ツールとしては以下を使いますが、それらの使用方法はご理解いただいているものとします。

WorldEditor 2.1.0（通称 WED）                                                                          
Blender 2.79                                                                                       
XPlane2Blender V3.5                                                                              
Gimp 2.10                                                                                                                                                   
Text エディタ(ワーﾄﾞパッド等)  
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2. シーナリー作成のしくみ                              

2.1 シーナリーを構成する素材                                                           

シーナリー以下のファイルから構成されます。

・DSF ファイル(.dsf)  ----   地表を緯度/経度各 1°毎に分割した領域 (タイル)で、以下の地形メッシュと素材配
置情報を含みます。                                                          

地形メッシュ (Base Mesh) ：各節点を緯度/経度/高度の座標で表したメッシュデータです。このファ

イルは、個人使用以外は変更禁止の様です。（Alpilot 社）

素材(Overlay)の配置情報：ここで言う素材とは、地表及びその上に現れる素材（滑走路や建物など）

です。ファイル形式になると Art Asset とも呼ばれます。引用する素材情報と WED 等
で指定された場所情報を含みます。

・空港情報(apt.dat)   -------  WED で指定した、空港名称や滑走路の位置情報等の情報です。

・新規素材と画像ファイル ---- WED のライブラリにない新規素材とそ

のテクスチャ画像です。素材の種類には表 2.1
のものが有ります。素材とテクスチャ画像は同
じフォルダ内に拡張子以外は同じ名前で保存す

る事を推奨します。その方が、5.2 項の Textures
設定で楽になります。                       

・ライブラリ情報 (library.txt) -------- シーナリーパック用に作成した素

材を WED のライブラリ枠(Library pane)に表示す

る情報。作成は任意。詳細は 8 参照。

                                                      
シーナリーパックを作成する前に必要な素材 (.obj, .fac, .pol...)を準備し

ます。次に WED にて素材の位置情報その他を入力し、シーナリーパッ

クを作成します。作成されたシーナリーフォルダを X-Plane 11 / Custom Scenery フォルダ内に入れます。例えば、
以下の様なファイル構成になります。                                                                  
                                                     
＜シーナリパックの構成例＞
 .. / X-Plane 11/ ←X-Plane 11 を収容しているフォルダ                      

      └ Custom Scenery/   
        └ New Scenery Pack/ ←シーナリーパック名称(X-Plane 上に表示されるものとは別)
             ├ Earth nav data/ ←WEDが作成するフォルダ                                
             │   ├ +30+130/    ←シーナリを含む緯度/経度各 10°の名称のフォルダ
             │   │　 └ +35+139.dsf    ←.obj, .fac 等を何処にどの様に配置するかの情報
             │   └ apt.dat ←空港情報、表2.1または 3項参照
　　　　　　 │　                                                                                
             ├ Overlay/ ←任意名称のフォルダ、シーナリーパック内なら任意の場所に複数作
成可
             │    ├ hanger.obj ←構成素材ファイル
             │    └ hanger.png ←構成素材のテクスチャファイル
             │     　         ：  
             │                                                                                  
　           └ library.txt                           ←ライブラリ公開を宣言するファイル。シーナリーパック直下に

置く事。                                                     
 
この例の中で Earth nav data およびその配下のファイルは WED が自動的に作成する。この例では北緯 35°、東

経 139°のシーナリーを扱っているので+30+130 のフォルダが出来ている。その下に、WED で指定した各種構

成素材の配置などのデータは+35+139.dsf ファイルで纏められる。

シーナリの素材 (.obj .fac など) 任意名称のフォルダに収納し、そのテクスチャ画像は同じフォルダ内に格納
する。             
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表 2.1　シーナリーを構成する素材 (Art Asset)

項 構成素材                           説明

1 地形画像
Terrain 

.ter 地形メッシュに張り付ける画像情報をこのファイルで指定します。資料 3 参照。ファ

イルフォーマット（資料 3）はあるが、その適用方法不明。

近づいた時に画像を精細にする Decal 命令文（資料 14 参照 ）が資料可。           

2 空港情報 apt.da
t

シーナリーパックには１個の空港ファイル(apt.dat)が必要です。従って近くに既存
の空港が有っても仮の空港を作成します。詳細は３項参照。（資料 2 照 ）

3 ﾄﾞﾚｰﾌﾟ型
ﾎﾟﾘｺﾞﾝ
Polygon

.pol 

 

   
    

このファイルで比較的狭い領域に画像を貼ります。.ter ファイルが個々の地形メッ

シュ単位で画像を貼り付けるのに対し、.pol ファイルは地形メッシュ上の任意の領域

に画像を貼り付けることが出来ます。ただし.ter ファイルに比べて描画速度が遅いの
で、広いか又は多数の領域の指定は推奨されない。                              
WED のライブラリから貼り付ける画像の.pol ファイルを選択し、貼り付ける領域を指

定します。適当な.pol ファイルが見つからない場合は 4 項を参照し作成します。     

近づいた時に画像を精細にする Decal 命令文（資料 14 参照 ）が使用可。隣接のタイ
ルにまたがって描画する事は出来ません。                                      

4 線
Line 

.lin     地形メッシュ上の誘導路等に線を描きます。WED のライグラリ

（▶ ▶ ▶lib airport lines）にいくつかの線の例があります。（資料 12 照 ）            

5 ｵﾌﾞｼﾞｪｸﾄ
Object

       

        

.obj    

     

地形メッシュ上に配置する 3D モデルです。Blender 等の 3D エディタにより作成

し、X-Plane 用オブジェクトファイルに変換されている必要があります。Show/Hide や
移動のアニメーションが可能。
WED 上で、使用する.obj ファイルを選びマップ枠で場所をクリックすると、その地点
にそのオブジェクトが置かれます。モデルの置かれ方は、オブジェクトに以下の方式
が設定されています。詳細は 5.1 項の補足 1 参照。

1) 通常型の場合：オブジェクトは傾かず、オブジェクトの原点が地形メッシュに
乘る形で置かれる。

2) ドレープ型の場合：地形メッシュの凹凸に合わせ覆いかぶせる様に、オブジェ

クトを変形させ置かれます。X-Plane が勝手にオブジェクトをメッシュ分割し底

面が地形メッシュに沿う様に変形させます。その為 CPU 処理量が増えるので、
あまり多く使わない方がよい。塀やフェンス等はこの方式を使う。            

3) Tilted 指定の場合：オブジェクトは地形メッシュの傾きに合わせ、傾けて置かれ
ます。

                                                     
その他詳細は 5 項参照。

                                                                            

6 ﾌｧｻｰﾄﾞ
Facade     

.fac ファサードは（オブジェクトとは異なり）任意の寸法の建物等を、表面の貼付け画像
の伸縮が目立たない様に作成します。WEDにて引用するファサードを選択し、WEDの
マップ枠で建物等の各コーナをクリックし多角形を描くだけで設置出来ます。
建物等の場合は閉じた多角形（ただし各コーナーは凸）で、塀などの場合は多角形は
閉じません。
ファサードは（オブジェクトと同様に）通常型のみの様です。
また、ファサードは壁の作り方の違いでType 1と Type 2があります。詳細は6項を
参照。                                                                      

7 森林
Forest      

.for ライブラリに登録された木の側面図から木を作成しメッシュの上に配置します。詳細

は資料 8 参照。   

                                                                            

8 線上配置 .str .obj で指定された物体を線上に配置する。（資料 11 参照 ）

9 海岸情報
Beach       

.bch 水と陸の境目の特性（砂地など）を設定します。
                                                                            

10 道路網 .net 点と線からなる道路網(3D)の設定し、交通と表面画像を定義します。（資料 9 参照 ）

11 ﾗｲﾌﾞﾗﾘｰ
   

librar
y.txt

シーナリーパックで新規作成した.obj を WED のライブラリ枠に表示したい場合はこ
のファイルを作成し、シーナリパックの直下に保存します。他のユーザも使える様に
なるので、強く推奨されます。 
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2.2 シーナリー描画のながれ
シーナリーで物の前後関係を正しく表現する為に、X-Plane は以下のルールで構成素材を描画する様です。

概ね下記の順序で、原則として遠い物から手前の物への順で描画される様です。

1) 他にシーナリー設定が無い地域は、X-Plane 11 / Grobal Scenery フォルダにある DSF ファイルでディフォル
トのシーナリが描かれます。

2) カスタム・シーナリは X-Plane / Custom Scenery フォルダ内の scenery_packs.ini にリストアップされています。

X-Plane はこのリストで視界内にあるものを選び、下の方から優先的に描画します。一方、写真シーナリー

や Alpilot の HD/UHD Mesh Scenery 等は、通常このファイルの下の方に保存されます。また一般のシ－ナ
リーパックは上からアルファベット順に格納されています。従って、視界内にあるシーナリについて、
・写真シーナリーや Alpilot の HD/UHD Mesh Scenery 等が先に描かれます。

・一般シーナリーはアルファベット順の上にあるシーナリが下位の順位にあるシーナリより上に書かれ

ます。この時、上の順位にあるシーナリーに Exclusion zone が有る場合は、下位のシーナリーパックが
配置した素材は描画されません。

3) 一つのシーナリーパック内では、WED の構成素材リスト枠(Hierarchy Pane)で配置されたリストの下のもの
から先に描かれ、リストの上位のものが一番上に描かれます。
ドレープ型ポリゴンの場合は.pol ファイル内の LAYER_GROUP 文で設定されます。(4 項参照)
ファサードの場合は LAYER_GROUP 文または LATER_GROUP_DRAPED 文で設定されます。(6.2 項参照)

                                                                           
4) オブジェクトに関しては、

・Layer Group 又は Draped Layer Group が設定されている場合は各グループ毎に一纏めに描かれます。グ

ループ名は X-Plane が決めたもので、その書き込み順は X-Plane が決めます。Layer Group 内で書き順に不

具合がある場合は Layer Group Offset 又は Draped Layer Group Offset で調整します。 (5.2 項の Layer
Grouping 参照) 

・他 Group や Groupn 名が None のオブジェクとの間で書き込み順位に不具合がある場合は、Override
Weight で調整されます。

・遠くにある物の表示を省略する為、親子すべてのオブジェクトについて LOD チェックされ表示が判断さ

れます。LOD は 5.2 項の Levels of Detail、及び 5.3 項の LOD:で設定されます。

・また、オブジェクトが置かれる場所が陸上であるか水上であるかでも表示が判断されます。 5.2 項の

Require Surface で設定されます。 

                                                                                         
5) ファサードについては、.fac ファイル内の MESH 文にて表示の最大限界距離が指定されます。（6 項参照）
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3. 空港情報(apt.dat)                                                                     

シーナリーパックには１個の空港ファイル(apt.dat)が必要です。従って近くに空港が有っても仮の空港(ヘ
リポート可)を作成する必要あります。注意が必要なのはAirport IDの設定です。本来はICAOコードを指定
したいところですが、X-Planeにインストールされた空港の中に、重複するICAOコードやAirport IDがあっ
た場合最初のものだけ空港リストに現れ、それ以降の物は無視されます(エラーは出ません)。Airport IDは
最大6桁まで設定できる様です。なお、一般のシーナリ作者はこの設定を、Airport ID = ”XX” + (3～4桁
の英字) とする事が提案されています。とにかく他のシーナリとバッティングしない事を祈って指定するし
かないです。                                                                                     

3.1 空港作成手順
事前にWEDの File → Prefereces… メニュー画面からLength Units で Metersを選択した方が良いかと思います。

＜新規作成手順＞
1) 作成する空港の緯度経度ヘリポートの緯度経度及び高度をGoogle Earth等で事前に調べて置きます。

・ヘリポート作成の場合は、発着点の緯度経度及び高度
・滑走路または水路作成の場合は、その始点と終点の緯度経度及び高度

2) WED を立ち上げ、画面下部の NEW ボタンを押します。

3) 空港リスト欄に追加された Untitled 1 をダブルクリックし、その名称を今回作成するシーナリパック名称
に変更します。その後 OPEN ボタンを押します。
この名称は今回作成されるシーナリパックのフォルダ名称になります。

4) WED のメイン画面が現れるので、Airport → Create Airport メニューをクリックします。

5) 右上画面の unnamed entry をダブルクリックし X-Plane で表示する名称を入力します。従って水路の場合
は最初に[s] を、またヘリポートの場合は[H]を付加します。

6) 右下の詳細情報枠で以下を入力します。
Name ：5)で入力した名称がそのまま表示されます。                            
Type ：Airport / Heliport / Seaportから一つ選びます。                     
Field Elevation ：設定する場所の高度を指定します。
Airport ID          ：ICAOコードや既存のAirport IDと重複しない英字4～6桁の空港記号を入力

します。ディフォルトのxxxxのままだと他とダブり、X-Planeで表示されな
い可能性が大きいです。            

　                                                                                                 
＜滑走路Airportまたは水路Seaportを設定する場合＞

7) 滑走路ツール または水路ツール をクリックし、画面中央の地図枠に始点と終点をそれぞれク
リックします。 表示される詳細情報枠で、

Name ：システムが指定する名称なので、そのまま使います。    
Latitude 1 ：始点の正確な緯度を入力します。
Longitude 1 ：始点の正確な経度を入力します。
Latitude 2 ：終点の正確な緯度を入力します。
Longitude 2 ：終点の正確な経度を入力します。

Length, Heading, Latitude Ctr, Longitude Ctrは自動的に計算され表示されます。その他の項目は、
WED マニュアル（資料 1）の 7. Property Reference を参照して下さい。    

                                                                                                 
＜ヘリポートを設定する場合＞

7) ヘリポート・ツール をクリックし設置場所のあたりをクリックします。表示される詳細情報枠で、
Name ：システムが指定する名称なので、そのまま使います。 
Latitude ：発着場所の正確な緯度を入力します。
Longitude ：発着場所の正確な経度を入力します。

その他の項目は、WEDマニュアル（資料1）の 7. Property Reference を参照して下さい。    
                                                          

8) 今回作成するシーナリー領域が既存のシーナリーと干渉する場合は、 ツールをクリックし干渉防止エ
リア(Exclusion zone) の左上と右下の角をクリックします。  

                                                     
9) 最後に File → Save メニューからファイルを保存し、File → Export Scenery Packをクリックすると、
自動的にapt.datファイルがEarth nav data フォルダの中に作成されます。                     
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4. ドレープ型ポリゴン(.pol)
.pol ファイルにて比較的狭い地形に貼る画像を指定します。描画速度は基礎メッシュの.ter 画像ほど早くない
ので、あまり広い領域の指定は推奨されません。
WED のライブラリから貼付け画像の.pol ファイルを選択し、貼り付ける領域を指定します。適当な貼付け画

像が見当たらなければ、.pol ファイルを作成します。貼付け画像は.pol ファイルと同じフォルダに同じ名前
（拡張子は除く）で保存するのが間違いが少なくて良い様です。                                       
近づいた時に画像を精細にする Decal 命令文も使えます。（資料 14 参照）                     
                                                                                                            
＜.pol フォーマット＞                                                          
A                                                                                                                                                     
850                                                                                                                                                                                     
DRAPED_POLYGON

TEXTURE <texture name> ←昼間の貼付け画像(.pol からのファイルパス含む)                                                  
TEXTURE_LIT <texture name> ←夜間の貼付け画像(.pol からのファイルパス含む)                                                  
TEXTURE_NOWRAP <texture name> ←昼間の貼付け画像(.pol からのファイルパス含む)                                                  
TEXTURE_NOWRAP_LIT <texture name> ←夜間の貼付け画像(.pol からのファイルパス含む)                                                  

SCALE <horizontal scale> <vertical scale> ←画像を貼付けた時の水平と垂直の大きさ（単位 m）を指定　
LAYER_GROUP <group name> <offset> ←貼付けグループ名、貼付け順の指定                                    
SURFACE <surface type> ←貼付け面の性質を以下の単語で指定する。
                                           water, concrete, asphalt, grass, dirt, gravel, lakebed, snow, shoulder, blastpad       
NO_ALPHA ←画像の α チャンネルを使わない旨宣言 
LOAD_CENTER                                                ←画像の中心をポリゴンの中心に合わせて貼付ける旨宣言する。ポリゴンが

画像からはみ出る場合は画像を繰り返す。 

＜.pol ファイルの例＞ 
 A
 850
 DRAPED_POLYGON
 TEXTURE concrete.png
 SCALE 25 25                                                                                                                                                                   
 LAYER_GROUP taxiways 0
 SURFACE concrete 

5.  オブジェクト(.obj)                                                              
オブジェクトを作成する前、Blender に XPlane2Blender のアドオンをインストールしておく必要があります。

5.1 項の注意を参考にオブジェクトの構成を検討し、オブジェクト作成中に 5.2 項から 5.2 項の設定項目を入
力します。
　　・Scene プロパティ設定（5.2 項参照）                                                                      
　　・Object プロパティ設定（5.3 項参照）
　　・Material プロパティ設定（5.4 項参照）                                                                   
　　・Texture  プロパティ設定（5.5 項参照）

最後に Blender の File → Export → X-Plane Object メニューで X-Plane 用オブジェクトファイル(.obj) を作成し
ます。                                                                                        
                                                                                              

5.1  Blender作図前の注意                                     
オブジェクトを作成する前に以下の注意が必要です。

・テクスチャ画像の 1 辺は 2 の指数倍の事。大きな画像を少ない数でカバーするのが良い様です。

・支点数が 24 以下のオブジェクトは非効率の様です。LOD 設定が同じ物でお互いに近くにある物は同じオブ
ジェクトに纏める。

・オブジェクト原点がシーナリの地上メッシュに乗る位置となる様に作図する事。入力数値の単位は m。   

・全ての子オブジェクトの Intensity 反射強度は全て同じ値に設定する事。（5.4 項の Specular Intensity） 

・オブジェクトは遠いものから近いもの順に作画されます。 従って互いに離れたオブジェクトは、遠近の

見え方が不安定になるので、一つの X-Plane オブジェクトにまとめない事。

・航空機の場合と同様に Show/Hide や Transform のアニメーションが可能、ただし Manipulation 設定は不可。
・オブジェクトはなるべく通常型オブジェクト(補足 1) とし、建物の土台も含め作成するのが良い。

・傾いた場所に置く場合はドレープ型オブジェクト(補足 1) にする事。ただし、処理速度が落ちるので数はな
るべく少なくし、一つのオブジェクトにまとめるのが好ましい。                                     

・金属光沢を表現したい物は一つの X-Plane オブジェクトにまとめる事。（Normal Metalness 設定でエラーに
なる為）                                                                                       
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・単純形状で数が多く、アニメーション設定の無いオブジェクトは Instanced Scenery Object（補足 2）とする。
描画速度が向上する                                                                             

                   
補足 1 ：オブジェクトを地形メッシュ上に置く際、以下の方法が設定可能。

1) 通常型：オブジェクトの原点が地形メッシュに乘る高さで、傾くことなく置かれます。
地形メッシュが傾いていると隙間が見える事があるので、建物は土台も含めてオブジェ
クト化するのが望ましい。地形メッシュとの隙間が問題となる場合は、5.2 項の Slope
Limit でオブジェクトを表示する地形傾きの範囲を指定出来る。
ドレープ型に設定されていなけれは通常型になります。

2) ドレープ型：オブジェクトの各メッシュは地形の凹凸に合わせて分割/変形され、オブ
ジェクトの底面が地形の傾きに沿う様に置かれます。布を地形に被せる様なイメージで
す。この方式はメッシュ変形のため描画処理が遅くなります。従ってこの方式のオブ
ジェクトはなるべく少なくする事。また一つの X-Plane オブジェクトにまとめる事。
地形メッシュの傾きがきつい場合や、塀やフェンスの様な場合はこの方式にします。
5.4 項の▼XPlane → Draped でチェックを入れて指定します。
ドレープ型の場合は処理速度が遅くなるので、LOD 設定範囲は通常型より狭くする様で
す。5.2 項の Levels of Detail → Max. Draped で、通常型とは別の LOD 設定が可能。

                                              
3) Tilted 指定：オブジェクトは地形メッシュの傾きに合わせ置かれます。5.2 項の Tilted でチェックを入れます。
                

                                                                                                            
補足 2 ：Instanced Scenery とは、Blender で同じオブジェクトを多数複製するする場合、一つの複製元オブジェクトを別レ

イヤに作成し、その他のオブジェクトはメインレイヤに原点の位置と向きのみを指定して複製を配置する方法で
す。ただし、アニメーションやスモーク設定があるオブジェクトには使用できません。
具体的には Blender で以下の手順でオブジェクトを作成します。

1) 複製の元になるオブジェクトを一つのレイヤの原点位置の作成する。この時オブジェクトの原点はシーナリ
に置かれた時に、地形メッシュに乗る位置とします。

2) Object タブの▼Groups で＋をクリックし、その名称(Group)を分かりやすいグループ名に変更する。
3) メインレイヤに戻り、インスタンス複製する位置にカーソルを置きます。Add → Group Instance メニュー

でカーソル位置にインスタンス複製します。
4) オブジェクトを保存した後、5.2 項の設定項目 Type:で Instanced Scenery Object を設定します。最後に File 

→ Export → X-Plane Object (.org)で X-Plane オブジェクトに変換します。
複製元となるオブジェクトは X-Plane オブジェクトと同じテクスチェを使わなければなりません。
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5.2  X-Planeオブジェクトの特性設定

Blender で作成したオブジェクトを X-Plane 用オブジェクトに変換する際に必要な特性を指定します。Blender のプロパ
ティ枠 Scene の中の▼XPlane にて設定します。
                                                                  
X-Plane Version: 最新のバージョンに設定します。

Export Mode:                 変換する対象の事で、必ず Layer を選択します。

Compile Normal-Textures 詳細不明

Name: X-Plane オブジェクトの名称を指定します。

Type: シーナリの場合、通常は Scenery Object を選びます。ただ
し簡単でアニメーションが無く数の多い場合は、インスタ
ンス複製でオブジェクト作成し Instanced Scenery Object を
選びます。(複数の .obj が同時に GPU で処理される）

                                                                  
Textures 

Autodetect Textures 通常はチェックを外します。チェックを入れると
5.5 項の▼Image   Source:設定の画像ファイルが使われます。
チェックを外した場合、以下の項目に.png 又は.dds の貼り
つけ画像を指定します。
この画像は X-Plane オブジェクトと同じフォルダに収納す
るのが良いようです。その事により画像ファイル名の最初
に // を加えるだけで済みます。

                                                                  
Default 昼用の画像のファイルパスを指定 

                                                                  
Night 夜用の画像のファイルパスを指定 

                                                                  
Normal　　　　凹凸/反射画像のファイルパスを指定

Draped　　　　ドレープ型ポリゴンで地形に合わせ変形された部分
を別のテクスチャで表現することが出来る様です。そのテクスチャのファイルパスをここで設定し
ます。

                                                                                                    
Draped Normal   同上の場合で、Normal テクスチャのファイルパスのファイルパスをここで指定します。         

                   
Levels of Detail                                                    

X-Plane オブジェクトで扱う LOD 設定の具体的な表示範囲を設定します。個々のオブ
ジェクトについては、5.3 項の LOD:で表示範囲を指定します。LOD は表示範囲を分け
て定義します。近いものから順に、Lvel of Detail 1→ Lvel of Detail 2 → … Lvel of Detail
4 (最大) で指定します。                                                       

　　LODs: LOD を設定する総数(最大 4)を指定。各 LOD 表示範囲の設定欄が現れる。

Near: LOD 範囲の近限界(単位 m)を指定。
     Far; LOD 範囲の遠限界(単位 m)を指定。
                                                                                

注 1) 各 LOD 範囲に隙間がない事。そうしないと画像がちらつく場合あり。
つまり、ある範囲の遠限界と次の範囲の近限界は等しいこと。代表的
な設定例を以下図に示す。

    

          LOD                Near           Far     
    Level of detail 1            0         1000
    Level of detail 2      1000         4000
    Level of detail 3      4000       10000

注 2) LOD を設定しなかったら、メッシュは強制的に one- sided として扱わ
れるらしい。        

                                                    
Max. Draped LOD: ドレープ型オブジェクトの場合は、処理速度を悪化させ

ない様に通常型オブジェクトより近くても表示を中止します。その表示最
大限界を指定します。(単位 m)
0.00 (ディフォルト) は出来る限り表示するの意味。
上記の Type 設定で Instanced Scenery である事。

8 / 22



Scenery properties                                                                         

Layer Grouping オブジェクトは、以下に示す Layer Group 毎にまとめて X-Plane
が判断した順序で描かれます。各 Group 内で書き込み順に不具
合がある場合は Offset により調整が可能です。

                                           
Layer Group:    　通常型オブジェクトをグループごとに纏めて描画したい場合が

あります。とり纏めの為オブジェクトに Layer Group 名を付けま
す。以下の中から選びます。飛行場を想定した名前で、他の名
前は使えません。
None(ディフォルト), Cars, Light objects,  Roads, Airports,
Markings, Runways, Taxiways, Shoulders, Beaches,  Terrain
同じ Layer Group 内で書き込み順が正しくない場合は Layer
Group Offset で調整します。X-Plane が決めた順番で OK の場合
を 0 とします。-5～+5 の数字で設定します。-2 の設定では X-
Plane の決めた順番より 2 レイヤ先にこの Layer Group を描きます。

Draped Layer Group:　ドレープ型オブジェクトの場合はこちらから Layer Group
名を選びます。選べる名前は上記と同じです。

　              None(ディフォルト), Cars, Light objects,  Roads, Airports,
Markings, Runways, Taxiways, Shoulders, Beaches,  Terrain
Draped Layer Group Offset の設定は上記の場合と同様です。   

　Cast shadows　　　シーナリーにこのオブジェクトの影を投影する場合チェックし
ます。ただし処理速度下がります。これ以外に 5.3 項の Material
設定で、いくつかの影の投影が指定されます。

Slope Properties 　　シーナリの地形メッシュの傾きで、オブジェクト表示をするか
しないかを決めます。

Slope Limit　　 地形の傾斜角度がある値を超えた場合そのオブジェクトを表示しない場合はチェックし、その限界
を以下に設定する。建物の土台までオブジェクトに含まれている場合は、この限界は大きくても良い
はず。複数のオブジェクトをまとめてある領域に配置した場合でも、X-Plane はそれぞれのオブジェ
クトでこの判定を行います。
オブジェクトの前方を Y 方向、右方向 X 方向とする。-90 から 90 の範囲で角度を指定すること。

Min. Pitch: obj の前方が下方向に回転した時の表示限界角度(°) 　
Max. Pitch: obj の前方が上方向に回転した時の表示限界角度(°) 
Min. Roll: obj の左側が下方向に回転した時の表示限界角度(°) 
Max. Roll: obj の左側が上方向に回転した時の表示限界角度(°) 

                                                                                                            
Tilted     地面が傾斜している場合、オブジェクトも同様に傾ける時にチェックします。(5.1 項、補足 1 参照)

         
Require surface:   そのオブジェクトが地上にあるか水上にあるかで表示を切り替えられます。例えば橋げたの場合、水上

のオブジェクトと水中のオブジェクトの両方を作成しておくと、水に濡れた色が表されるそうです。
Any 地形メッシュが水面(Wet)であるか陸上(Dry)であるかにかかわらずオブジェクトを表示する。　　　　
Wet 地形メッシュが水面(Wet)の場合のみオブジェクトを表示する。                                   
Dry 地形メッシュが陸上(Dry)の場合のみオブジェクトを表示する。                                   

                                                                                                            
                                                                                     
                           

5.3  Blender内オブジェクトの特性設定
Blender 上で選択されているオブジェクトの X-Plane 特有の特性をプロパティ枠の
Object タブで指定します。

▼XPlane
Datarefs              Add Dataref を押して、使用する Dataref を設定します。  
Manipulator      シーナリでは使用不可。チェックしません。
 
LOD　　事前に 5.2 項 LOD:で LOD 表示限界の設定します。その設定のどれを適用

するかをここで指定します。チェックボックスの左から、Level of detail 1,
Level of detail 2, Level of detail 3, Level of detail 4 となります。全てにチェッ
クが入っていない場合は全ての LOD 範囲で表示されるものとします。

                                                                
Override Weight　オブジェクト内に似たものがある場合、どれを優先に使うかの順

序を指定する様です。詳細不明。
Weight:         ディフォルトは 0。詳細不明。

                          
Custom Properties      TBD                                                                                                       
Custom Animation Properties    TBD
Conditions     TBD
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5.4  Blenderの Material特性設定
Blender で作成する各オブジェクトについて、プロパティ枠の Material タブにて以下
設定します。
Link Material は必ず Data に設定します。
                                                                            
▼Specular　 Intensity: 輝度の設定。X-Plane オブジェクト内ではすべての物が同じ

値である必要あります。

▼Shadow 影の効果を設定する。シーナリの効果のほどは未確認。
　

                                                                            

                    
▼XPlane

Draw Linked Objects   当該オブジェクトを描画するはずなので、必ずチェックを入
れます。                                                 

Draped                      このオブジェクトをドレープ型 (5.1 項、補足 1 参照) に宣言し
ます。

                                                                            
Normal Metalness　金属光沢効果が得られる。XP11 以降のみ。全ての子オブジェク

トも同じ設定にしないとエラーになります。
Normal map の青チャネルをベースに反射強度を出すらしい。

                                                                            
　Blend:                                                                
    Blend Shadow      不明

Alpha Blend　　 貼付け画像に透明部分がある場合その通りに表現する。
Alpha Cutoff 貼付け画像の α 値で透明/不透明の区別を分ける。カットオフ比

率は下記で指定する。

Blend Glass         昼間用画像の透明部分(α チャンネル)がこの値以下の場合完全に
を明にする時にチェック入れる。（11.0x 以上）

Alpha Cutoff Ratio:     Blend:で Alha Cutoff を選択した場合、α 値(0～1.0) がこの
値以下は 0（完全透明）に設定する。

                                                                           
Surface Behavior         以下の表面の種類によりシミュレーションの表現効果を切り分

けます。
Surface Type:   　ディフォルトは None、特に分類しない普通の面の意味。

他に Blasted, Shoulder, Snow, Lakebed, Gravel, Dirt, Grass,
Asphalt, Concrete, Water　から選択可能。

                                                                           
Deck　　　　　　当該オブジェクトの下を飛行機が通過できる場合はチェック

します。
                                                            

Camera collision   シーナリでは無効。飛行機のコックピットの場合のみ有効。
                                                                       

Light levels 
Override Light Level   このオブジェクトの夜間の画像が Dataref で制御される場

合にチェック入れます。例えば光がゆっくり点滅する等の効果
を出せます。

Value 1:　 Dataref の値がこの値以下の時、Override レベルをこの設定値に
する

Value 2: Dataref の値がこの値以上の時、Override レベルをこの値にする。
1 以上も設定可能。                                      

Dataref            画像の制御され方を指定する。 Value1 と value2 の間は補間さ
れる。

                                                                           
Instancing Effects　Instanced Scenery (5.2 項 Type: 参照) を宣言したオブジェクトの

表示効果を指定できる様です。
                                                                           

Tint 　　　　　　オブジェクトが遠くにある時淡く見せる機能を指定する場合
にチェックを入れます。                                  

Albedo             昼用画像の濃度を 0 .0～1.0 で指定。0 は完全に薄い、1 は完全
に濃い。

Emissive          昼用画像の放射強度を 0.0～1.0 で指定。0 は完全に弱い、1 は
完全に強い。                                      

                                                             
Polygon Offset 　　原則として X-Plane は遠いオブジェクトから近いオブジェクト

の順に書きこみます。通常 X-Plane にその順番を任せるので、
0（ディフォルト）に設定します。あるオブジェクトが隠れて見えない場合は順番 1～を指定します。
数字が多いほど上に描かれる様です。                                                      
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5.5  Blenderの Texture特性設定
Scene プロパティの設定で Autodetect Textures (5.2 項)にチェックが入っている場
合は以下の設定が有効になります。プロパティ枠の Texture タブで設定します。

Material Texture Slot     ここで指定される Texture を使うようとする。

Type:     　　　　 　  Image or Movie に設定する事。

▼Image

     Source　　　 　Single Image とすること。
Autodetect Textures (5.2 項)にチェックが入っている場合
は、ここで示される画像ファイルが使われる。画像ファ
イルは Blender ファイルからの相対ファイルパスを指定。
以下の設定も有効になる様です。

                                                                       
                                                  

                                                                       
▼Mapping 
                                                                       
     Coordinates:         UV を選択します。
                                                            
     Map                       UV Map を選択します。

 
▼Influence      以下の項目の設定が有効。効果不明。
     Diffuse: → Color:　　　　昼間画像に有効                             
     Shading: --> Emit:　　　　夜画像に有効
     Specular: --> Intensity:　　Specular Texture に有効                       

       Geometry: --> Normal:　　Normal Texture に有効 
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6. ファサード(.fac)                                                                      
ファサードとは、WED 等で指定された建物等の外形線(Polygon)を、同じく WED で指定された高さに近い高

さまで立ち上げて壁(Wall)を作り上部(Roof)を平面で閉じる事により、構造物をシーナリ上に作る機能です。
任意サイズの建物を表面のテクスチャ歪があまり目立たない様に作れるのが特徴です。ファサードには壁の

作り方により Type1 と Type2 の種類があります。また。それぞれの Type にはオプションで Scraper 機能を付与
する事が出来ます。
ファサードはメモリの節約になる訳ではない様です。ファサードの数が増えるとその分メモリが使われます。
また.fac ファイルは Text ファイルなので、Text エディタにて作成します。.fac ファイルを作成してくれる 3D
エディタは今のところ無いようです。

6.1 Type1ファサード                                          
Type 1 ファサードでは画像のエリアを組み合わせて壁や屋上が作成されます。作成されるファサードは WED
で指定する幅や高さから多少異なりますが、テクスチャの歪は出ません。基本的に直方体の構造物を作るの

に適しています。その他、オブジェクトと同じ Layer_Group 設定、最上層の壁を内側に倒す設定、LOD 設定

も出来ます。(資料 6, 7)                                                                                                      

6.1.1 壁の作成原理                                      
最初に WED で建物外壁の幅(W) と屋上の高さ(H)が指定されます。それぞれの壁は .fac ファイルの内容に
従って以下の様に作成されます。

1) 壁や屋上を作る画像全体が何 m のサイズで作図されるかが設定されます。(ROOF_SCALE文、SCALE 文)

2)画像を上下3つの層に分け、最下層をBOTTOM、中間層をMIDDLE、最上層をTOPとします。それぞれの層の
境界の画素値を決めておきます。各層の画素数から作られる高さを組み合わせて壁の高さ(H)を作ります。
WEDで指定した高さに足らない場合は、必要な数だけMIDDLE部分を繰り返します。従って、実際に作成さ
れるファサードの高さはMIDDLEの高さ分だけ誤差が出ます。詳しくは6.1.2項のBOTTOM, MIDDLE, TOP参
照。

                                                                    
3)また、画像を左右3つの枠に分け、最左枠をLEFT、中間枠をCENTER、最右枠をRIGHTとします。それぞれ

の枠の境界の画素値を決めておきます。各枠の画素数から作られる幅を組み合わせて幅(W)を作ります。
WEDで指定した幅Wに足らない場合は、必要な数だけCENTER部分を繰り返します。従って、実際に作成さ
れるファサードの幅はCENTERの幅だけ誤差が出ます。詳しくは6.1.2項のLEFT, CENTER, RIGHT参照。

この処理を各壁に施します。この方式により小さい画像で広い建物外壁にテクスチャを貼れ、壁の幅や高さ
の指示に依存せず画像の伸び縮みが出ません。
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6.1.2 Type 1ファサード文法
以下に Type 1 ファサードの命令文を解説します。                                                     
                                                                                                            
A                                                                                                                             
1000 ファサ－ドである事を示す固定ヘッダです。
FACADE

GRADED この命令文が無い場合(ﾃﾞｨﾌｫﾙﾄ)はファサードはドレープ型になり、地形メッシュに
沿ってファサードは変形します。これは柵などに使えます。
この命令文が有る場合、ファサードの最初の壁の中央 (WED の壁表示で小さな丸が現

れる箇所?) が地形メッシュに乗る高さで、傾くことなく置かれます。これは通常の建物
等に応用できます

                                                                                                            
LAYER_GROUP <offset> <group> ドレープ型でない通常のファサードをシーナリー要素のどの LAYER_GROUP

に含めるかを規定します。指定するグループ名を<group>、そのグループ内で表示する

優先順を<offset>で指定します。<group>は 5.2 項 Layer Group と同様に terrain, beaches,
shoulders, taxiways, runways, markings, airports, roads, objects, light_objects, cars の何れ

かでなければなりません。<offset>は、-5～+5 の数値で X-Plane が決めた順序で良けれ

ば 0 を指定します。<offset>=-1 の場合は一つ早く描かれます。この命令文が無ければ 

<group> = objects で<offset> = -5 と見なされます。                                 
                                                                                                       

LAYER_GROUP_DRAPED <offset> <group>  ドレープ型ファサードの場合に、どの LAYER_GROUP に含めるかをこの文
で規定します。内容は同上。                                                    

                                                                                                            
RING 0/1 ファサードの壁を構成する多角形を閉じるか、開くかを指示します。RING 1 の場合は、

WED で多角形のコーナーを 3 カ所以上指定し Enter を押すと多角形は閉じます。通常の

建物に使います。RING 0 の場合は閉じません。柵などの場合に使います。          
 

SHADER_WALL 次行の TEXTURE 文は壁 (Wall) に使われる事を宣言します。次行に TEXTURE 文が来

ます。もし SHADER_WALL および SHADER_ROOF 文が無い場合は、TEXTURE 文は
壁のみに使われます。

TEX_SIZE <width pixels> <height pixels>  以下に記述するテクスチャ画像の幅方向画素数、高さ方向画素数定義します。
1つのファサ－ド内で複数回定義でき、直下のテクスチャ座標にのみ適用されます。 

                                                                                                                                           

TEXTURE <texture name>                                                                                                                                                                         
TEXTURE_NORMAL <texture name >           テクスチャ画像のファイル名を定義します。                            

TEXTURE_LIT <texture name>                                                                                                                                                                
                                                                                                            
SHADER_ROOF 次行の TEXTURE 文は屋上 (Roof) に使われる事を宣言します。もし SHADER_ROOF

文が無い場合は、TEXTURE 文は壁と屋上両方に使われます。                     

                                 
HARD_WALL <surface> 壁が固い、つまり物がぶつかっても通り抜けられない事を定義します。<surface>は 5.4

項の Surface Type の中から選びます。例えば Concrete。
    

HARD_ROOF <surface>                  屋上が固い、つまり物を乗せられる事を定義します。<surface>の設定は同上。
                                                                                                            
DOUBLED 0|1 ディフォルトでファサードの内面は透明になります(DOUBLED 0)。柵などの様に面の

両面が見える場合は DOUBLED 1 を指定します。窓を通して内面が見える場合も同様

です。DOUBLED 1 の場合 X-Plane は表と裏の面を別々に作るので形状データが増えま
すが、光の当たり具合が正しく表現されます。

                                  
FLOORS_MIN <floors> FLOORS とはこの場合、壁を上下方向に分割する単位(BOTTOM, MIDDLE, TOP)の事で

FLOORS_MAX <floors> す。WED で建物の高さを設定しますが、その値がファサード文にある BOTTOM, 
MIDDLE, TOP から実質的に作成可能な範囲から外れると、変なファサードになってし

まいます。それを防ぐ為に FLOOR の最小数と最大数を指定します。                

                                                                                                            
LOD <near meters> <far meters> そのファサードを目視出来る距離範囲を指定します。<near meters>は近限界(m)。<far 

meters> は遠限界(m) 。この命令文は次に指定する壁全てに適用されます(別の LOD 文が

来るまで)。ただしフレームレート悪化を防ぐ為、LOD 文は 1 個までにすべきとの事で
す。

                                                                            
ROOF <x pixels> <y pixels> 屋上 (具体的には WED で定義した多角形) のテクスチャを切り出す為のコーナ点(1 点)

のテクスチャ上の座標を定義します。屋上が四角であれば 4 個の ROOF 文が必要です。

次の ROOF_SCALE 文の代わりに使います。                                             
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ROOF_SCALE <left> <bottom> <x> <y> <right> <top> <x_scale> <y_scale> 屋上 (具体的には WED で定義した多角形)

のテクスチャを切り出す領域およびその領域がカバーする長さ(m)を規定します。上記

ROOF 文の代わりに使います。

<left>　切出し領域の左端の x 座標(画素)
<bottom>　切出し領域の下端の y 座標(画素)
<x>　参照点 (WED の多角形で壁に小さな丸が現れる箇所) の x 座標(画素)
<y>　参照点 (WED の多角形で壁に小さな丸が現れる箇所) の y 座標(画素)
<right>　切出し領域の右端の x 座標(画素)
<top>　切出し領域の上端の y 座標(画素)
<x_scale>　上記<left>と<right>が切出す領域が何 m の長さをカバーするか規定する。

<y_scale>　上記<bottom>と<top>が切出す領域が何 m の長さをカバーするか規定する。

                                                                                                 
BASEMENT_DEPTH <pixels> 壁の下端 (つまり BOTTOM の下端) から何ピクセルまでを地表より下とするかを指定

する。この設定により地形メッシュが傾いていてもファサードの下端に隙間が見えなく
なります。GRADED 文の指定がある場合に有効です。

                                                                             
WALL <min width> <max width> [<min heading> <max heading>]  壁作成条件を規定します。

<min width>は壁の最小幅(m)、 <max width>は 壁の最大幅(m)を
指定します。当該壁の向きを限定したい場合は、<min
heading>で壁の向きの最小値、<max heading>で壁の向きの最大

値を指定します。壁の向きとはファサードの正面（Node 1 と

Node 2 の間の面）の向きを 0°とした相対角度で、0～360 度の

値で示されます。この壁の向きは<min heading>と<max
heading>範囲内にある事を宣言しています。この指定によりこの壁が正面から右なのか、
左なのか、裏正面なのか判断できます。
複数の WALL 文を記述する事ができます。条件が和えが X-Plane はランダムに壁を選択
します。
                                                                                                                                                

WALL_RULE <min width> <max width> <min heading> <max heading> 直前に書かれた WALL 文の第二候補をこ
の文が規定します。いずれか条件が揃えばこちらの壁が使われるとの事です。

                                                                                                                                                                  

SCALE <meters per texture x> <meters per texture y> 　壁 (Wall) のテクスチャ画像全体が描かれる幅方向、および高さ方

向のサイズ(m)を定義します。このサイズは他のWALLと同じでも、WALL文ごとに指定
にする必要あります。

ROOF_SLOPE <degrees> [SLANT]         Slant 指定が無ければ、最上層つまり TOP の先端を内側にず
らされ屋根の傾きが表現されます。この場合は、建物の高さは変わ

りませんが TOP 部分の画像が歪みます。

Slant 指定があれば、TOP 部分が内側に回転し屋根の傾きが表現さ

れます。この場合は TOP 部分の画像は歪むことは有りませんが、建
物の高さは低くなります。                                     

                                                                                                            
BOTTOM t1 t2                                                                                                                                                       
MIDDLE t1 t2                                                                                                                               
TOP t1 t2                                                                                                                                                                                         
LEFT s1 s2                                                                                                                                            
CENTER s1 s2                                                                                                                                          

RIGHT s1 s2                                                                                                                                                             
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壁のパターンを元に、 1 つの壁を上下 3 つのエリア (BOTTOM, MIDDLE, TOP) および幅
方向に 3 つのエリア (LEFT, CENTER, RIGHT) に分け、テクスチャ画像でそれぞれのエリ
アのを分ける境界の座標 (s1, t1) を左の命令文で指定します。それぞれの境界に隙間があ
無いようおに設定します。また壁のパターンが複雑である場合は MIDDLE を複数設定す
る事ができます。
WED で壁の幅と高さを設定すると、 X-Plane は次のルールで各エリアを組み合わせ壁を
作ります。

1) 壁の幅が狭く高さが低い場合は、 X-Plane は下端および左端のエリアから使い始め、
次に上端および右端のエリアを使います。

2) 壁の幅が広く高さが高くなると、 MIDDLE を使い、それ以降設定された MIDDLE 文
の順にエリアが選択されます。　 

これら命令文は BOTTOM→MIDDLE→TOP さらに LEFT→CENTER→RIGHT の順に記述
する事。ただし BOTTOM, MIDDLE, TOP のセットと LEFT, CENTER, RIGHT セットの順
番が入れ替わっても可。



6.1.3 ファサード文の構成            
Type 1 ファサードの.fac ファイルは以下の階層を持ちま
す。

1) 最初にファサード全体に適用される命令文が記述され
ます。
・ファサード型かどうか
・適用されるテクスチャファイルと貼付けサイズ指定
・表面は固いかの特性
・裏面も見える様にするか
・階層のあるべき設定範囲

2) LOD 文と次の LOD 文の間に、その LOD が適用され
る壁や屋上の条件が定義されます。
・LOD
・屋上テクスチャの貼付け寸法
・地面から下の部分の画素数 

3) 上記 LOD が適用される壁について、WALL 文以下次

の WALL 文までの間に、その壁に適用される条件が
記載されます。
・壁テクスチャの貼付け寸法
・最上部(TOP が複数あればその最上エリア)の傾き

・壁を縦横に分割する境界のテクスチャ座標  

WALL 文が 1 つの場合は、全ての壁に同じパターンが使

われます。複数の WALL 文が有る場合は、条件の合う

WALL 文の中から X-Plane がランダムに採用します。
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 ファサード全体の条件宣言
      GRADED 文
      LAYER_GROUP 文または LAYER_GROUP_DRAPED 文
      RING 文
      SHADER_WALL 文 + TEXTURE 文
      SHADER_ROOF 文 + TEXTURE 文
      TEX_SIZE 文
      HARD_WALL 文
      HARD_ROOF 文
      DOUBLED 文
      FLOORS_MIN 文
      FLOORS_MAX 文

 LOD 毎の条件設定 (1 つまでにすべき )
    LOD 文
    ROOF 文
    ROOF_SCALE 文
    BASEMENT_DEPTH 文

 壁の条件設定壁の条件設定
     WALL 文
     WALL_RULE 文 
     SCALE 文
     ROOF_SLOPE 文
     BOTTOM 文
     MIDDLE 文
     TOP 文
     LEFT 文
     CENTER 文
     RIGHT 文

 別の壁の条件設定 ( 複数可 )



6.2 Type 2ファサード
立体的な壁を扱う場合このタイプを使います。壁のデータ構造はオブジェクトと同じです。従って、オブ
ジェクトと同様なものが壁と配列される感じです。ただし壁の幅に合わせる為、そのオブジェクトは伸縮さ

れます。更に 90°角部では断面は 45°に伸びます(これが良い場合とそうでない場合があります)。
その他、オブジェクトと同じ LAYER_GROUP 設定、壁及び屋上に任意オブジェクト付加、敷地ポリゴン作成、

LOD 設定、壁をベジェ曲線で指定などの機能が可能です。詳細は資料 6, 7 参照。

6.2.1 壁の作成原理
壁のパターンが共通な部分を Blender で作成し、

その .obj ファイルを元に .fac ファイルを作成す

るのを推奨します。(以下の手順参照)
                                            
1) 各壁においてある幅のパターンが同じである領域を

一つのセグメントとし、それぞれのセグメントを

Blender でオブジェクトとして作成します。

地表の開始点を原点(0,0,0)とし、Y 軸の+方向に壁を

水平に伸ばし、Z 軸の+方向に高さを伸ばします。

また壁の外側は X 軸の+方向にします。

2) 各セグメントにテクスチャ画像を貼り付けて X-Plane 用オブジェクト (.obj) に変換します。

3) その.obj ファイル内の VT 文を.fac ファイルの所定の場所にコピーし、“VT”を
“VERTEX”に文字変換します。この作業は文字変換量が多いのでワードパッ

ドの様な Text エディタを使います。そのほかセグメントの配列(SPELLING 文)
など必要な命令文を記載します(6.2.2 項下参照)。

4)  .fac ファイルをシーナリーフォルダに配置し、WED でそのシーナリーを開き

ライブラリ枠の▼Local からそのファサードを選択します(注 1)。次に建物外

壁各コーナ(各壁幅 W) と右図の Height を設定します(注 2)。これを元に X-
Plane は、.fac に記載されているセグメントの中から最も Height が近い物を選

び、SPELLING 文で指定された順序でセグメントを配列し壁を作ります。指
定された全ての面について同様に壁を作成します。

                                                                                   

注 1. ここでそのファサードが表示されれば一応成功です。何

かエラーが有ると WED は強制的に閉じます。何もメッ
セージが出ないので、つらいですが自分で原因を探すし
かないです。

注 2. .fac ファイル内には複数の高さの壁データ(FLOOR 文)を記

載しておく事が出来ます。X-Plane は Heightで指定した高

さに最も近い FLOOR データのみを表示します。従って

FLOOR 文が一つしか無いファサードは Heightでどんな高
さを指定しても、表示される建物の高さは同じです。

注 3. WED で Select → Select Verticies を選択すると WED のアト
リビュート枠に右図の様な各コーナの設定が表示されま
す。最初に設定したコーナ(Node 1)と次のコーナ(Node 2) 
の間の壁がこのファサードの正面となります。
また、Wall 欄では Wall文の wall name が選択出来るので、

使用する WALL を選ぶことが出来ます。                                                                 

                                                                          

6.2.2 Type 2ファサード文法
以下に Type 2 ファサードの命令文を解説します。 
                                                                                                            
A                                                                                                                             
1000 ファサ－ドである事を示す固定ヘッダです。

FACADE

GRADED この命令文が無い場合(ﾃﾞｨﾌｫﾙﾄ)はファサードはドレープ型になり、地形メッシュに
沿ってファサードは変形します。これは柵などに使えます。この命令文が有ると、ファ
サードの最初の壁の中央が地形メッシュに乗る高さで、傾くことなく置かれます。これ
は通常の建物等に応用できます。
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LAYER_GROUP <offset> <group> ドレープ型でない通常のファサードをシーナリー要素のどの LAYER_GROUP
に含めるかを規定します。指定するグループ名を<group>、そのグループ内で表示する

優先順を<offset>で指定します。<group>は 5.2 項 Layer Group と同様に terrain, beaches,
shoulders, taxiways, runways, markings, airports, roads, objects, light_objects, cars の何れ

かでなければなりません。<offset>は、-5～+5 の数値で X-Plane が決めた順序で良けれ

ば 0 を指定します。<offset>=-1 の場合は一つ早く描かれます。この命令文が無ければ 

<group> = objects で<offset> = -5 と見なされます。                                 

LAYER_GROUP_DRAPED <offset> <group>  ドレープ型ファサードの場合に、どの LAYER_GROUP に含めるかをこの文
で規定します。内容は同上。                                                    

                                                                                                            
RING 0/1 ファサードの壁を構成する多角形を閉じるか、開くかを指示します。RING 1 の場合は、

WED で多角形のコーナーを 3 カ所以上指定し Enter を押すと多角形は閉じます。通常の

建物に使います。RING 0 の場合は閉じません。柵などの場合に使います。
 

SHADER_WALL 次行の TEXTURE 文は壁 (Wall) に使われる事を宣言します。次行に TEXTURE 文が来

ます。もし SHADER_WALL および SHADER_ROOF 文が無い場合は、TEXTURE 文は
壁のみに使われます。

TEXTURE <texture name>                                                                                                                                                                         
TEXTURE_NORMAL <texture name >           テクスチャ画像のマイル名を定義します。                              

TEXTURE_LIT <texture name>                                                                                                                                   
                                                                                
SHADER_ROOF 次行の TEXTURE 文は屋上 (Roof) に使われる事を宣言します。もし SHADER_ROOF

文が無い場合は、TEXTURE 文は壁と屋上両方に使われます。

ROOF_SCALE <meters x> [<meters y>]   屋上 (具体的には WED で定義した多角形) に適用されるテクスチャ画像が

貼り付ける全体長さ(m)を規定します。

<meters x>　x 方向の長さ(m)を規定する。

<meters y>　y 方向の長さ(m)を規定する。

                                                                                    
NO_WALL_MESH 壁をを透明にする宣言文です。この壁はオブジェクトを配置する役目のみとなります。

NO_ROOF_MESH 屋上を透明にする宣言文です。この屋上はオブジェクトを配置する役目のみとなります。

                                                                                                                                                           
OBJ <file_path > 使用予定のオブジェクトを全てここで宣言します。当該ファサードからの相対パスで示

す。ファサード内で使用する全てのオブジェクトの数だけ OBJ 文を記載する。この命

令文の順に0から始まる追番<index>がそのオブジェクトに設定されます。テクスチャ

画像は.obj ファイル内で設定されます。
                                                                                                            

FLOOR <name> 分かり難い様ですが、ここで言う FLOOR とは建物の高さで種類分けする仮名称の意味

です。このFLOORの名称を<name>に記載します。名称は作者の便宜の為だけに記載し

ます。FLOOR文は高さの低いものから順に記載しなければなりません。次の FLOOR 文

までの間に SEGMENT, MESH, WALL, SPELLING 等を指定します。

 複数のFLOOR文を置く場合は次のFLOOR_HEIGHTの低い物から順に記載する必要ありま
す。                                                                          

ROOF_HEIGHT <height> Roof の高さ(m)を定義する。WEDで指定するHeightは何故か1m単位でしか設定出来
ない様です。またWEDで指定するHeightに相当するFLOOR_Heightデータが無
い場合は、強制的に近いROOF_HEIGHTの壁データが選ばれます。この値を0に設

定すると Roof は地形メッシュに貼り付き、Draped Layer Group (5.2 項参照)の扱いとな
ります。

  

TWO_SIDED_ROOF この Roof が内側から見える場合はこの文必要。
 

HARD_ROOF <surface> この Roof の全ての床がハードになります。機体が乗せられる様です。<surface>は 5.4
項の Surface Type つまり Blasted, Shoulder, Snow, Lakebed, Gravel, Dirt, Grass, Asphalt, 
Concrete, Water の中から指定する様です。     

ROOF_OBJ <index> <s> <t> [<lo> <hi>] 屋上に<index>番目のオブジェクトを画像の <s>,<t> の位置に配置する。<lo> 
<hi>は（記載が有れば）X-Plane 上の出現頻度の下限と上限を意味しｓます。1～6の数
字で指定します。1はほとんど現れない、2はたまに現れる、3はまあまあ現れる、6は
ほとんど現れる。                                                              
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ROOF_OBJ_HEADING <index> <s> <t> <r> [<lo> <hi>] 向き<r>を指定出来ること以外は、上記の ROOF_OBJ 文と同

様にオブジェクトを配置します。向きはファサードの正面壁（Node 1 と Node 2 の間の

面）との相対角度(°) で入力します。

ATTACH_GRADED <index> <x> <y> <z> <heading> [<lo> ,hi>] <index>番目の OBJ を<x>,<y>, <z>のセグメントと

の相対位置に、<heading>の角度(-90～90 度の範囲)回転させて取り付ける。セグメント

の垂直外側を0度とする。<lo> <hi>は、記載が有れば出現頻度の下限と上限を意味する。

通常型オブジェクト(5.1 項、補足 1)の場合この文を使う。                          

ATTACH_DRAPED <index> <x> <y> <z> <heading> [<lo> ,hi>] ドレープ型オブジェクト(5.1 項、補足 1)の場合はこ
ちらの文でオブジェクトを配置します。

 

SEGMENT <optional debug index number> セグメントデータの開始を宣言します。<optional debug index number>
はセグメント番号で、指定が無ければ0から始まる整数になります。この文以降に

MESH 文、VERTEX 文、IDX 文が記載され、セグメント形状が指定されます。

SEGMENT_CURVED <optional debug index number> セグメントがベジェ曲線で指定された場合この命令文が使わ

れます。ベジェ曲線で指定する予定が無くても、SEGMENT 文と同じ内容のものを付け
加える必要あります。そうしないとエラーになます。                       

MESH <group> <far LOD> <cuts> <vertex_count> <idx_count> 当該セグメントで、この Mesh 文が描くメッシュの

表示限界距離<far LOD>で、その表示限界内の表示順位を<Group>で指定します。LOD
指定が同じメッシュは<group>の小さい方から順に描画されます。例えば内部のメッ

シュを group=0 とし窓ガラスを Group=1 に設定すれば、カラス窓の内側に内部が正しく

描画されます。<group>は 0 から連続的に指定し、セグメントが変わるとリセットされ
ます。                                                                        
<cuts>は一つのセグメントが水平方向に何個のメッシュに分割されているかの数です。

<vertex_count>は VERTEX 文の総数を示します。

<idx_count>はメッシュを構成する節点の総数を示します。

                                                                     
VERTEX <x> <y> <z> <normal x> <normal y> <normal z> <texture s> <texture t> Mesh 文の直後に節点の番号（0

から始まる連番）順に VERTEX 文を並べます。<x> <y> <z>は座標、<normal x> <normal
y> <normal z>は垂直単位ベクトルの xyz 成分、<texture s> <texture t>は貼り付け画像の

ST 座標(比率)を示します。

これら内容は.obj ファイル内のVT文と同じです。従って複雑なネッシュの場合は

Blender でオブジェクトを作成し、X-Plane 用に変換後に.obj ファイルの VT 文を

VERTEX に書き換えるだけで済みます。ただし文字変換機能のある Text エディタが必
要になります。

                                                                  

IDX <list of indices> VERTEX 文の直後にこの文が置かれます。メッシュは複数の三角形から成ります。

メッシュをBlenderで作成しX-Plane用に変換した場合、<list of indices>は0からの連
番をメッシュの数×3の数だけ記入すれば良い。                                  

                                                                                                                                   
WALL <min width> <max width> <min heading> <max heading> [<wall name>]  壁作成条件を規定します。<min width>を

壁の最小幅(m)、 <max width>を 壁の最大幅(m)、<min heading>を壁の最小向き、<max 
heading>を壁の最大向きとします。X-Plane は、WED で指定された幅と SPELLING 文で

指定された組み合わせの幅を比較し最も近い幅の SPELLING 文を採用します。必要に

応じ各セグメントの幅を伸び縮みさせます。壁の幅の限界値を<min width> <max width>
とします。

                              各 WALL の向きはファサードの正面（Node 1 と Node 2 の間の

面）の向きを 0°とした角度で、0～360 度の値で示されます。

この壁は<min heading>と<max heading>の間の向きの壁ですと
宣言しています。この事によりこの壁が正面なのか、横なの
か、裏正面なのか判断できます。
非公式ですが、<wall name>を記載するとWEDでその壁の名称

として表示される様です。同じ内容の WALL 文が複数あった場合は、X-Plane はその中
の一つをランダムに選び、外観の多様性を向上させるそうです。

WALL_RULE <min width> <max width> <min heading> <max heading 直前に書かれた WALL 文の第二候補をこ
の文が規定する。いずれか条件が揃えばこちらの壁が使われるとの事ですが、詳細不明。

SPELLING <list of segment index numbers>  その壁を構成するセグメントの組み合わせを定義します。セグメントの

番号の間はスペースを空けること。その壁の最大幅（WALL 文の max width 値）をカ
バー出来るだけのセグメント数を含むことが必要です。セグメントが不足すれば配列は
繰り返されます。セグメントが余る場合は最小幅の組み合わせが使われます。この様に

して X-Plane はセグメント幅を拡大縮小し壁の幅を WED の設定に合わせます。
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6.2.3 ファサード文の構成              
Type 2 ファサードの.fac ファイルは以下の階層を持ちます。

1) 最初にファサード全体に適用される命令文が記述され
ます。
・ファサード型かどうか
・どの LAYER_GROUP に含めるか

・適用されるテクスチャファイルと貼付けサイズ指定
・表面の性質
・裏面も見える様にするか
・屋上に置くオブジェクトの指定

2) FLOOR 文の下 (次の FLOOR 文までの間) に、その壁の
データを記載する。
・壁に配置するオブジェクトの指定
・壁の類似した部分(セグメント)の特性設定

・セグメントの特性設定
・セグメントを構成するメッシュの図形情報

3) 上記 FLOOR に使われる壁を定義する為、WALL とその

下に (次の WALL 文までの間) 、その壁を表現する内容
が記載されます。
・壁が表現される条件
・壁を構成するセグメントの配列情報               
                            

WALL 文が 1 つの場合は、全ての壁に同じパターンが使わ

れます。複数の WALL 文が有る場合は、条件の合う

WALL 文の中から X-Plane がランダムに採用します。
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 ファサードの基本条件宣言
      GRADED 文
      LAYER_GROUP 文または LAYER_GROUP_DRAPED 文
      RING 文
      SHADER_WALL 文 + TEXTURE 文
      SHADER_ROOF 文 + TEXTURE 文
      ROOF_SCALE 文
      NO_WALL_MESH 文
      NO_ROOF_MESH 文
      OBJ 文

：
：

 屋上の条件設定屋上の条件設定 (FLOOR_HEIGHT 毎に作成 )
      FLOOR 文
      ROOF_HEIGHT 文
      TWO_SIDED_ROOF 文
      HARD_ROOF 文
      ROOF_OBJ 文
      ROOF_OBJ_HEADING 文

 上記 FLOOR 内の 1 つの壁データ
      ATTACH_GRADED 文
      ATTACH_DRAPED 文
      SEGMENT 文
      SEGMENT_CURVED 文
      MESH 文
      VERTEX 文
      IDX 文     

同様に別の高さの壁データを定義する。 ( 低い
方から順に )

 壁の作成条件を指定
      WALL 文
      WALL_RULE 文
      SPELLING 文



6.2.4 Type 2ファサードの実例
以下に文例として Brick_House.fac を紹介します。この例は FLOOR 文が一つし

か無いので、WED 上で高さの選択は出来ません。固定の高さのものしか表示さ
れません。
 
A                                                                                        
1000
FACADE

GRADED　　　　　　　←必ず必要な宣言文
RING 1　　　　　　　　←多角形は閉じます。
SHADER_WALL　　　　←壁の画像を以下に指定                                   
  TEXTURE Textures/Brick_House.png
SHADER_ROOF　　　　←屋上の画像を以下に指定
  TEXTURE Textures/Brick_House_Roof.png
  ROOF_SCALE 20　 　←屋上の画像の表示は 20m 四方とする。

FLOOR F1_Floor　　　　←建物の高さを示すフロア名はとりあえず F1_Floorとする。
ROOF_HEIGHT 5.5　　　←屋上の高さは 5.5m とする。この高さは固定。                                                        

SEGMENT 0 　　　　　　←SEGMENT 0を設定する。                                                                         
  MESH 0 200 1 72 24　　←Group は 0 (つまり X-Planeの順序に従う)、LOD 遠限界を 200m、VERTEX 文総数 72、節点数 24 とする。
    VERTEX
 　　　：            SEGMENT 0の各節点の座標等を記載。節点の数の VERTEX文が必要。.obj の VT 文からコピーする。
    VERTEX
    IDX 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 
    IDX 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 　　0 から節点の数だけ並べれば良い。
    IDX 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71                                                                                                            

SEGMENT 1　　　　　　← SEGMENT 1 を設定する。
  MESH 0 200 1 72 24
    VERTEX
　　　：　　　　　　　　　同上
    IDX 
                                                       
SEGMENT 2　　　　　　← SEGMENT 2 を設定する。
  MESH 0 200 1 72 24                                                                        
    VERTEX                                                                                      
　　　：　　　　　　　　　同上
    IDX
                                                       
SEGMENT_CURVED 0
  MESH 0 200 1 72 24
    VERTEX
　　　：                                               
    IDX

SEGMENT_CURVED 1 　上の SEGMENT 0、SEGMENT 2、SEGMENT 2
  MESH 0 200 1 72 24 　をコピーし、SEGMENT を SEGMENT_CURVED
    VERTEX 　に書き換えれば良い。

：       
        IDX

SEGMENT_CURVED 2
    MESH 0 200 1 72 24
       VERTEX

：       
       IDX                                                                

WALL 3 20 0 0 With_Door  　←ドアのある壁(With_Door)を最小幅3m、最大幅20m、で作る事とする。
SPELLING 1
SPELLING 1 1

：    　表示したいセグメントの組み合わせを幅の小さい方から順に並べる。 
SPELLING 1 0 1 0 1 0 2 0 1 0 1 1
SPELLING 1 0 1 0 1 0 2 0 1 0 1 0 1

WALL 3 20 0 0 Without_Door  　←ドアの無い壁(Without_Door)を最小幅3m、最大幅20m、で作る事とする。
SPELLING 1
SPELLING 1 1

：    　壁の無いセグメント番号を幅の小さい方から順に並べる。
SPELLING 1 1 1 1 1 1 1 1 1 1 1 1
SPELLING 1 1 1 1 1 1 1 1 1 1 1 1 1
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6.3 Scraper機能
TBD 

7.  その他構成素材の設定
 TBD

 

8.  ライブラリー                          
シーナリーで使用する素材(.obj, .pol, .fac 等)が完成した後、それらを纏めた

library.txt を作成しシーナリパックのフォルダ直下に保存します。この事により、

そのシーナリーパックが PC にインストールされていれば、それら素材をだれでも

WED のライブラリー枠(右図)から引用することが出来ます。

ただし、それ以降は素材および画像の名称や場所を変更することは出来ません。
素材で使用する画像は素材からの相対場所で指定されます。
X-Plane はシーナリーパックで引用している素材を、最初に Custom Scenery 内の各
シーナリーにある library.txt を調べ、目的の素材が無ければ X-Plane の Resorurces /
default scenery を調べ探します。
                               
library.txt のファイル名は固定です、変更する事は出来ません。

library.txt をシーナリーパックに保存しておけば、他の人がその素材を使う事が可
能となります。ライブラリー上の素材ファイル名は後日変更可。
                                    
日本独自の素材の場合、WED のライブラリー枠(右図)のツリー構成に▼JP を設け、
その中に収納する事を提案します。

▼Library ▼lib ▼g10
                ▼JP               →  日本用に新規作成する。

▶Houses 　 → 適当にフォルダを作り、素材とテクスチャ画像を入れます。

以下はシーナリーパック側のツリー構成例です。library.txt とライブラリーに追加するオブジェクトの場所に
注意。

X-Plane 11 / Custom Scenery /
             └ JP_Asset / → シーナリパック名称（仮名）
　　　　　　　　 ├ Earth nav data/                                                                                                                               
                 ├ Houses /
                 │  ├ Home.obj → 追加した素材の例
                 │  ├ Home.png → 上記素材のテクスチャ画像の例
                 │  └ 　：
                 ├ Objects /                                                                                                                                 
                 │　：
                 └ library txt → シーナリパック内の.obj や.fac を WED のライブラリに表示する為の文。下記例参照。
                                                                 
                                                                                                            
＜library.txt 文のフォーマット＞                                                                                
A                                                                       
800                                                                                                                                                                                                    
LIBRARY
PUBLIC
EXPORT <virtual path> <real path>                                                                                            
   ：

＜上記オブジェクトの library txt 記載例＞                                                                       
A
800
LIBRARY
PUBLIC
EXPORT lib/g10/JP/Houses/Home.obj Houses/Home.obj　　　→テクスチャ画像は.obj から指定されるので記載不要。
　　：                                                                                
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9.  参考資料
 

資料１  WEDマニュアル WorldEditor Manual
https://developer.x-plane.com/manuals/wed/index.html#addingobjectsandauto-generatingscenes

資料２ 空港設備設定 Advanced Airport Creation
https://developer.x-plane.com/?article=advanced-airport-creation

資料３  タイルテクスチャ仕様 Terrain Type (.ter) File Format Specification
https://developer.x-plane.com/article/terrain-type-ter-file-format-specification/ 

資料４ デカール設定仕様 Using Decals to Add Detail To Scenery
https://developer.x-plane.com/article/using-decals-to-add-detail-to-scenery/
   

資料５ オブジェクト仕様 OBJ8 (.obj) File Format Specification
https://developer.x-plane.com/?article=obj8-file-format-specification 

資料６ ファサード仕様  X-Plane 10 Facade (.fac) File Format Specification
https://developer.x-plane.com/article/x-plane-10-facade-fac-file-format-specification/

資料７ 森林仕様 Forest (.for) File Format Specification
https://developer.x-plane.com/article/forest-for-file-format-specification/

資料８   道路網仕様 Vector Network (.net) File Format Specification
https://developer.x-plane.com/?article=vector-network-net-file-format-specification

資料９ 地表部分テクスチャ仕様 Draped Polygon (.pol) File Format Specification
https://developer.x-plane.com/article/draped-polygon-polfac-file-format-specification/ 

資料１０ 線上配置仕様 Autogen String (.ags) File Format Specification
https://developer.x-plane.com/article/autogen-string-ags-file-format-specification/
           

資料１１ 線画像仕様 Painted Line (.lin) File Format Specification
https://developer.x-plane.com/article/painted-line-lin-file-format-specification/
 

資料１２ ライブラリ登録仕様 Library (library.txt) File Format Specification
https://developer.x-plane.com/article/library-library-txt-file-format-specification/

資料１３ デカール仕様    Using Decals to Add Detail To Scenery
https://developer.x-plane.com/article/using-decals-to-add-detail-to-scenery/
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